Website Management
with the CMS
In Class Step-by-Step Guidebook
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Quick Reference Links
CMS Login
http://staging.montgomerycollege.edu/cmslogin.aspx

Sample Department Site URLs (staging site)
Department template:
http://staging.montgomerycollege.edu/edu/department.aspx?id=x
Department2 template:
http://staging.montgomerycollege.edu/edu/department2.aspx?id=x

Interactive Demonstrations
http://www.montgomerycollege.edu/Departments/cpod/cms/

CMS Reference Guide
includes instructions for topics beyond the scope of this class
http://cms.montgomerycollege.edu/referenceguide

CMS Resources
includes link to the Montgomery College .edu Web Style Guide and process checklist
http://cms.montgomerycollege.edu/cmsresources
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Class Description
This class is an introduction to the most essential skills required to create and maintain department Web
sites using the Ektron Content Management System (CMS).
This is a hands-on workshop. CMS user IDs and passwords will be issued at training.
For more information about the .edu redesign project, visit http://www.montgomerycollege.edu/redesign/.

Category: Technology Resources

Subcategory: Web Development

Target Audience: Web content managers who need to create a new department site in the CMS or move
their department site into the new design templates

Prerequisites: Before signing up for this class, complete steps 1-4 of the process for redesigning a
department Web site: http://cms.montgomerycollege.edu/cmsroadmap.

Key Outcomes
• Login to the CMS and access department folders and content in the Work area.
• Use the editor to insert and style text, tables and images according to the Montgomery College .edu
Web Style Guide.
• Upload files and images to the Document Management System (DMS).
• Create hyperlinks and bookmarks.
• Create the department header, menu, and main content areas.
• Preview and publish Web content.

Before Taking this Class
Complete Steps 1-3 in the CMS “Road Map” (http://cms.montgomerycollege.edu/cmsroadmap),
including:
• Develop a site map and reviewed/updated content for the site
• Preview the available templates and selected one
• Submit and have the OIT CMS Web Site Request Form approved by your dean/director
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Getting Started
Get Your User name and Password from the CMS Instructor
Log into the CMS “Staging” Site, and Open a CMS Example Page
1.
2.
3.
4.
5.
6.

Go to the login URL: http://staging.montgomerycollege.edu/cmslogin.aspx
When the page opens, Click the Login button (upper left).
When the dialogue box opens,
Enter your temporary ID & password and Click “Login.”
Click OK when the alert pops up, redirecting you to EDU.
The Staging Site MC EDU page will appear. Wait until the page loads. There will be a yellow
“Developer Toolbar” at the top.
7. Copy/Paste this “Example Page” URL into its address bar:
8. http://staging.montgomerycollege.edu/edu/department.aspx?id=23765
9. Briefly review the content areas on this example page.

Open the Workarea - This is the application where you upload files to the Staging site, create and layout
content for your pages, and publish content to the “Public” site.
1. Click the “Workarea” button in the Developer Toolbar at the top of your page.
2. A new browser will open on top of the Staging site browser.

Find your own practice folder for this class
1. Click the “Content” button in the lower left.
2. The “Content Work-area” will open.
3. Use the folder tree (upper left) to navigate to the folder for this class date. EDU -> Training ->
Class-date (dd-mm)
4. In the class date folder, click on the sub-folder having your temporary user name.
5. Your “Workarea” folder opens with its content-blocks displayed in the right panel.
(Write down the ID number for “My Practice Content Block.” It‟s in the 3rd column.)
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Preview “My Practice Content Block” on the Staging Site
1. Return to the browser-tab containing the “Example Page” at
http://staging.montgomerycollege.edu/edu/department.aspx?id=23765
2. Replace the 4 numbers at the end of the URL with the ID number you wrote down.
3. Hit ENTER on your keyboard to load the page.
4. Temporarily save this page in Favorites – for this class.
5. Keep this browser tab open during your editing session.
Preview Modes: NO and YES.
When the Staging site initially loads, the Preview Mode (in upper right) is set to “NO.”
(See the right side of the Developer‟s Toolbar.)
When Preview Mode is set to NO:
A blue bullet appears in the upper left of the content area. Only published content is
viewable.
When Preview Mode is set to YES
You can view both published and recently “checked-in” content.
6. Set Preview Mode to YES: Click the “Preview” button on the Developer Toolbar.

What Are Assets and Content Blocks
In the editor, the right-hand panel of the Workarea displays your “Assets” and “Content blocks.”
• Assets are graphics
or documents
you have uploaded to the CMS.
If you have media assets (video or audio), upload them to the Podcast Builder (MC‟s podcasting
application).
• Content blocks are HTML data-base records
assets.

- HTML displays your text, hyperlinks and

The Department 1 Template: Three Basic Areas
(Refer to Staging Site browser with your practice content.)
1. The Department Header Area can contain up to three content-blocks, each with a unique ID:
• Department Banner Image
• Department Title
• Department SubTitle
2. The Department Menu Area (on the left). It is not shown in the Workarea with your other
content blocks but can be separately viewed and edited.
3. The Page Content Block (center-right) contains one content-block ID at a time. This is the ID
in the browser address field and it automatically loads the header and menu blocks.
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Understanding the Four Main Views of Your Content
Workarea Folder-View
When you click on your folder, you will find a
list of your Content Blocks and Assets (pdfs,
docs, images, etc).

Workarea Content-View
When you click on a content block title in the
folder area, the Workarea Content View for
that item will display. This view shows the
contents of the database record, but not the text
or image styles.

Content Block Edit-View
When you open a content block in the editor,
all of the text and image styles will be
displayed. Since the editor is larger than the
Web page template for your content area, the
general layout, including text-wrap of
paragraphs, may be slightly different than it
will be when previewed on the Staging or
Production sites.
“Staging Site” Preview and the “Production
Site” View
These views will accurately represent your
content. It is best to develop the habit of
checking page layout on the Staging site.
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Publish, Check-in, Save, and Cancel

•

Publish: Save and Publish on the live site, and Make it preview-able on the staging site.
Do not use “Publish” ( use “Check-in” only) until you are ready for your site to go live. When ready,
please email OIT Web Services at redesign@montgomerycollege.edu . After they publish your initial site,
you will be free to publish any subsequent pages or edits.

•

Check-in: Save and Close (Not Publish) on the staging site. Make it preview-able on the staging
site, Allow co-workers to edit it. Checked-in content will not appear on the “Public” site until you
“Publish” it.

•

Save: and keep editing on the staging site, but do not publish it on the live site.
We strongly recommend using “Check-in” instead of Save

•

Cancel: and return to the Workarea Content View to exit the editor and revert content back to the
previously checked in or published state.

Introduction to Text Styling
You have selected your folder and the Workarea should be displaying your assets and content-blocks.
Open a content-block in edit-mode
1. Click on “My Practice Content Block” in the right panel of the Workarea.
2. The “Workarea Content Viewing Panel” opens showing the content for the block you selected.
IMPORTANT: This is not the editor. It only displays the data-base record.
3. Click the Edit button
in the upper left to open the content-block in edit-mode.
4. The Editor opens
5. Practice styling text, referring to the Montgomery College .edu Web Style Guide

All styles in the Montgomery College Web site are controlled by an external style sheet
maintaining a consistent look and feel throughout the site. Please review the Montgomery
College Web Site Style Guide handout for additional style options you can apply to your
content, images and tables from within the CMS editor.
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Uploading Document and Image Assets
Documents have file extensions like: .doc, .docx, .xls, .xlsx, .pdf
Images have extensions like: .gif, .jpg, .png
How to upload single files
1. Navigate to the CMS folder where you will store the images, (currently your training folder.)
2. Roll your mouse over the
button in the Workarea toolbar.
3. Select DMS Document from the drop-down menu. The upload dialogue box opens. (NOTE:
DMS means “Document Management System.” Use “DMS Document” for literally all types of
non-HTML documents and images.)
4. Type a name in the Title field. Type content-type first, for example: “Image – a photo of
something”
5. Click “Browse” to navigate to the file on your computer. The Windows file-dialogue box opens.
6. Navigate to the folder where your file (CMS Training . . .)
7. Select the file and Click “Open.” After clicking “Open” the choose-file box closes.
8. Click the “Publish” button in the upper left of the editor in order to make the file available for
preview. NOTE: “Check-in” will save the document or image, but it won‟t appear in previewmode until the document or image is “published.”
9. The screen will display “One Moment Please. . .” then . . . Your successful upload will be
confirmed when the Workarea shows your image, or for a document, its download-icon and title.

Practice Uploading Assets (Examples are in the CMS Training Materials folder on your Desktop.)
• Upload an image and a document from the folder.

Inserting Images
“My Practice Content Block” should already be open in the Editor. If not, please open it now.
We will be inserting images into text-areas.
1. Click your mouse into the text at the location where you want to place the image.
2. Click the “files, images, hyperlinks” icon
3. The CMS Library for that folder will pop open in a separate browser. It will show the images that
have been stored there. NOTE: In Firefox this browser may appear behind your editor and you
may have to select it using your Windows “quick-launch” bar.
4. Double-click the image you want to insert.
5. The “Picture Properties” dialogue box will appear.
6. Type a title into the title field so that accessibility laws are satisfied.
7. Click “Insert File” to place the image at the cursor location in your content.
8. The Picture Properties dialogue box will close and the image will appear at the cursor location in
your content.
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Styling an Image
The image must be placed into your content in order to style it.
1. Click the image to select it. You will see small handles surrounding the image and your mouse
cursor will change to cross-hairs. (May take a couple of tries.)
2. Open the “Apply Styles” menu
3. Styles “image-left” and “image-right” will force the image to one side of the content area and
allow text to wrap around the other side.
a. Select the Image, open “Apply Styles,” and select “image-left” or “image-right.”
b. The image will jump to either the left or right margin, then drag the image to the vertical
position you desire relative to the body of text. The text will flow around it.

Practice Inserting and Styling Images
• Open “My Practice Content Block” in the editor.
• Follow the instructions for “Practice Inserting and Styling Images.”
• When finished, click “Check-in” and then preview the content in the Staging Site.

Adding Hyperlinks and Bookmarks
Text or images can be hyperlinked to the following:
•
•
•
•

Web pages outside the CMS (external links),
Another MC Unit‟s or Department‟s CMS content block and document asset
Your other CMS content blocks and document assets, and to
“Bookmarks” . . . anchor-locations on your page to which hyperlinks can jump

Creating an external hyperlink to a non-Montgomery College Web site
1. In the edit-mode, highlight the text or image that will become your link.
2. Click the “Hyperlink icon”
A “Hyperlink” popup window will open.
3. Make sure the “Type” field had “http:” selected.
4. Enter the full URL in the “Link” field. (NOTE: It is wise to open that URL in a separate browser
copy the address, right-click to copy it, then return to this dialogue and right-click to paste it into
the URL field.)
5. Select “New Window (_blank)” in the Target Frame field (to prevent users from navigating away
from your page) and Click OK.
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Creating an internal hyperlink to a page within the Montgomery College’s Web site
1. Follow steps 1-3 above.
2. In step (4.) do not enter the full URL. (Using “relative” urls will prevent your link from breaking
if the college moves from the „cms‟ domain to a „www‟ domain in the future.)
Instead:
a. Omit the “root directory” http://cms.montgomerycollege.edu/ and
b. Enter the only the directories and the content-block ID that follow it.
c. For example (Faculty & Staff Tab): /edu/tertiary1.aspx?urlid=69
Creating a link to one of Your Own Content Blocks or DMS Document Assets
1. In Edit mode, highlight/select the link - text or image.
2. Click on Files, Images, Hyperlinks
(If you have a popup blocker, hold the shift-key while
clicking.)
3. The Library Window will pop up.
4. Select the folder containing your assets in the directory-tree on the left.
5. Select “Quicklinks” from the drop-down menu. (Top of Library Panel.) Your assets should
appear in the list.
6. Double-click on the name of the asset for your link.
7. The Editor reopens and displays your linked text or image.
Adding a Bookmark (anchor) and a Quick Link to the Bookmark
1. Place your cursor directly to the left of the text or image to which you want the hyperlink to
“jump.” This will be your bookmark (anchor.)
2. Click the Bookmark icon
in the toolbar and the Bookmark naming dialogue will open.
3. Name the bookmark in the popup dialogue box and click Add.
4. Highlight the text or image that will become the link that jumps to the bookmark and in the
toolbar. Click the hyperlink button.
5. The Hyperlink dialogue box will open. Select the bookmark name from the Quick Link dropdown menu at the bottom and Click OK.
Practice Making Hyperlinks and Bookmarks
• Open “My Practice Content Block” in the editor.
• Follow the instructions for “Practice Making Hyperlinks and Bookmarks.”
• When finished, click “Check-in” and then preview the content in the Staging Site.
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Inserting a Table
1. In edit-mode place your cursor where you want the top left corner of the table to go.
2. Click on the table icon
in the toolbar.
3. The Insert Table dialogue will open
4. You may edit the following fields:.
a. Size: Rows and Columns: Enter any number of rows and columns (Remember: The
content area is a fixed width and tables will not scroll).
b. Layout: Width as Percent = % of Content Area
c. (NOTE: The CMS fixes your content area to 700 pixels by default).
d. Layout: Width as Pixels = size in absolute pixels.
e. Horizontal Alignment: Selection of left, center, or right will cause the table to snap to
those respective locations within the content-area. (NOTE: Alignment has no effect for a
table-width of 100% or 700 pixels.)
5. When finished, click OK in the upper right of the dialogue.
6. The table will appear in the editor as a gray-lined grid.
Practice Inserting a Table
•
•
•

Open “Practice Content Block” and follow the instructions for “Practice Inserting a Table.”
Check-in your content.
Note how the table appears in the Workarea Content and Staging Site views.

Default Table Styles: Edit-View, Workarea Content-View, & Live-View
This page assumes you have finished the above practice session.
Edit-View:
After inserting the table in edit-mode, the editor will supply a light gray
grid corresponding to the row/column and alignment that you specified
– as an aid to adding content to the table. However, the default table
style does not include this grid. Click “check-in” to see the Workarea
Content-View.
“Staging Site” and “Public Site” View:
When previewing your content blocks you‟ll notice your tables will
have alternating light blue rows and the grid lines are removed. You can
modify these default styles by adding custom table styles (Refer the
Web Site Style Guide to learn more about table styles.)
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Create a New HTML Content Block
1.
2.
3.
4.
5.

Roll over the
button in the upper left of the folder-view of the Workarea.
Select HTML Content from the drop-down menu.
The Editor opens
Type a Title (This will be displayed on the browser tab.)
Type a short sentence in the editing space below.

6. Click “Checkin”
(Saves and makes preview-able.)
7. The folder view will redisplay in your Workarea Content.

Create a New Folder
1.
2.
3.
4.

Roll over the
button in the upper left of the folder-view of the Workarea.
Select Folder from the drop-down menu.
The Folder Properties window opens
Type a Title for the folder

5. Click the “Add Folder” icon

Editing the Department Header Area
The Department Header Area automatically appears at the top of each of your pages.
Its three optional content blocks are already created for you:
• Department Banner Image ( logo or banner )
• Department Title
• Department SubTitle
Do not change the titles of these content blocks, only the names within them. The CMS uses the preset
titles to load the header into the browser, and your header will not display if you change the titles.
Example contains Banner Image, Department Title and Department SubTitle
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The Department Banner Image
1. Click the Department Banner Image content block. Remember: do not change the title of the
content block.
2. Click the Edit icon
in the toolbar to open the content block in the editor.
3. Insert the image into the content block, Publish, and preview your work in the browser.
4. IMPORTANT: Allow the CMS to automatically center the image. Even though the styles
“image-left” or “image-right” are available, the CMS will force the image to sit on the line above
the Department Title. Maximum width = 950 pixels, Height can vary.
The Department Title / SubTitle
Unlike other text, the Department Title and Department SubTitle have default sizes and colors.
1. Click the name of the Department Title / SubTitle content block.
2. Click the Edit icon
in the toolbar to open the content block in the editor.
3. Enter the department name/subtitle into the text field

Creating and Editing the Menu Area
• You can have single or sub-menu items
(See the examples)
• Menu width is fixed by default. It does not
shrink even if your menu names are all short.
Long menu-names will automatically textwrap.
• Menu font is fixed: Size, style, and color are
preset. You only enter text into fields when
editing a menu.
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Building a Single Item Menu
1. Click the View button in the Content View of your folder.
2. Select Menu.
3. The “View All Menus” page opens.
4. Click
- The “Add Menu” button allows you to add a menu. (NOTE: The “Back” button
will take you to the previous page.)
5. The “Add Menu” page opens.
6.
7.
8.
9.
10.
11.

Type a Menu Title in the title field and click “Save”
The “View Menu” page will open.
Roll your mouse over the Menu Name. A submenu will pop-up with selections.
Click “Add” to add an item to the menu. (NOTE: The “Reorder,” “Edit,” and “Delete” choices.)
The “Add New Item” screen will open (see the overview below).
Choose External Hyperlink and Click “Next”

An overview of the “Add New Item” options
•
•
•

Content Item = one of your HTML content blocks, in the main content area
External Hyperlink = a non-MC Web page that will open in a new or the current window
Sub Menu (see the CMS Reference Guide for instructions)

Adding the “External Hyperlink” Menu Item
12. After Clicking “Next,” the “Add New Item” screen opens.
13. Type the title of your menu item in the “Title” field.
14. Type the Web address for the external hyperlink in the “Link” field.
15. Click the “Save” Icon
in the toolbar
16. The “View Menu” page is refreshed. Your new item is added to the menu.

17. Repeat steps 8-15 to add additional external hyperlinks to the menu.
Adding “Content Item” Menu Items (content-blocks or documents)
1. Repeat steps 8-10 above.
2. Select „Content Item‟ from the Add New Item dialogue box and Click Next.
3. A checklist of your content-blocks and assets opens. Each checkbox you check will become a
separate menu item.
4. Check the items and then Click the “Add”
showing your new items added to the menu.

button. The “View Menu” page is refreshed,

Preview the menu area: Open any of your content blocks in the staging browser.
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Going Live
1. Confirm that your site meets the Web standards and guidelines.
2. After completing your site in the CMS, contact OIT Web Services. They will do the following:
a. Publish your Staging site pages to the web. After that, you will use the “Publish” button
to make subsequent pages and edits go live.
b. Activate your home page alias (an easy-to-remember URL)
c. Integrate your site into the overall .edu site (add a link to your content on the A-Z index
and on any other landing pages, as needed)
d. Set up a redirect on your original FTP site (so users who try to access the old URL get
redirected to the new one)
e. Archive and take down the original FTP site.
f. The “Production ” CMS Site is the system seen by the public. The URL is:
http://cms.montgomerycollege.edu/edu/
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